Guidance for Industry: Availability of Templates for Toxicology Data


Introduction to the Template For Subchronic Toxicity Study in Rodents
March 2004

General Instructions:  You can navigate the template either by pressing the "arrow" keys or by using the mouse.  The sections will expand as you type.  When you begin filling out a template, save it with a filename different from that of the template itself, so that you'll keep the blank template in your original file for future use.

To move quickly down the template to a specific section, click on the "View" menu, then "Document Map".  If you then click on a specific section name in the left-hand window, that section of the template will appear on the main screen.  Then close the left-hand screen to work on the template by selecting "View", "Document Map" again. 

In the event that the study contains additional types of information included as part of the experiment, you can add sections (with appropriate renumbering) as needed.

This template will also accommodate tables prepared in Microsoft Excel and Microsoft Access.

Many of the yellow highlighted areas in headings contain comments in a pop-up balloon or as hidden text.  These are suggestions or instructions relevant to that particular section.  They may be viewed either by moving your mouse over the yellow highlighted areas or by clicking on the ‘View’ menu, then ‘View Comments’  or ‘Markup’.  To prevent the comments from appearing in the printed document, cancel the ‘Markup’ command or select ‘Document’ under ‘Print what’ when you issue the ‘Print’ command. 

The templates were created in Microsoft Office 2000 software applications.  The comment sections in the templates may perform optimally with the same versions of the software applications.
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Subchronic Toxicity Study in Rodents 
Date of Submission:

Title of Petition or Notification:  


Name and Address of Petitioner or Notifier: 


I. Identification of Study

A. Study File Location: 

B. Study Title/Report Number: 

C. Name and Address of Testing Facility: 

D. Date of Study Report: 

E. Dates Study Conducted: 

F. Study Objective:  

G. Comments: 

II. Good Laboratory Practice

A. Good Laboratory Practice (GLP) Compliance? 

B. Quality Assurance (QA) Statement? 

C. Availability and Location of Original Data/Specimens/Test Substance: 

III. Executive Summary
IV. Materials and Methods
A. Test Substance

1. CAS name: 


2. Other name(s):


3. CAS registry number: 


4. Molecular structure: http://www.chemfinder.com
/ 
5. Purity:



6. Impurities: 


7. Stability: 


8.
Comments:


B. Test Substance As Administered

1. Batch/lot number: 


2. Route: 


3. Vehicle used: 


4. Tested adequately for concentration? 

5. Tested for homogeneity? 


6. Tested for stability? 


7. Problems with storage? 


C. Animal Diet
1.
Feed

a. Type:  



b. Name:



c. Availability: 


d. Analysis for contaminants: 

e. Comments: 


2.
Water

a. Source: 


b. Availability: 


c. Analysis for contaminants: 


d. Comments: 


D. Test Animals

1. Species/strain/substrain: 

2. Sex: 

3. Age range at initiation of study: 


4. Weight range at initiation of study: 


5. Quarantine/acclimation? 


6. Physical examination times: 


7. Number per cage:  


8. Environmental conditions: 


9. Comments: 

E. Experimental Design

1. Targeted dose levels: 


Table # [Heading]

	test group
	conc. in diet

(ppm or mg/kg)
	dose to animals

(mg/kg body-weight/day)
	number of males
	number of females

	Control
	
	
	
	

	Low
	
	
	
	

	Mid
	
	
	
	

	High
	
	
	
	


2. Total number of animals: 


3. Duration of study (including recovery period, if any): 


4. Length of exposure to test substance:
 

5. Were animals randomized? 


6. Recovery period: 


7. Comments:  


F. Body Weight And Feed Intake
1. Parameter examined: 
Table # [Heading]

	examined
	not examined

	
	Feed Intake* 

Feed Spillage* 

Water Intake*

Body Weight* 

Body Weight Changes*



*These parameters are recommended in REDBOOK for subchronic toxicity studies.

2. Comments: (e.g., list frequency) 
G. Cage-Side Observations

1. Parameter examined:  

Table # [Heading]

	examined
	not examined

	
	Appearance*

Abnormal Stool* 

Morbidity*

Mortality*

Neurotoxicity Screening (Specify parameters)*, **  





*These parameters are recommended in REDBOOK for subchronic toxicity studies. Add additional 

               parameters tested.

**The parameters for neurotoxicity screening may include, but are not limited to, the following: 

· Changes in skin, fur, eyes, mucous membranes, gait, posture, and response to handling, 

· Occurrence of secretions/excretions or other evidence of autonomic activity such as lacrimation, piloerection, pupil size change, unusual respiratory pattern, 

· Presence of clonic or tonic seizure, 

· Stereotype behaviors such as excessive grooming and repetitive circling, 

· Bizarre behavior such as self-mutilating and walking backwards, 

· Gross tumor development.

2. Comments:(e.g., list frequency) 

H. Opthalmological Examination
1. Parameter examined:  

2. Comments: (e.g., list frequency) 

I. Hematology

1. Fasting duration prior to blood collection: 
 
2. When in the study were the blood samples collected? 
.
3. How were the blood samples drawn? 


4. Dose groups and number of animals tested:
 
5. Parameter examined:  

Table # [Heading]

	measurement 

related to
	examined
	not examined

	red blood cells


	
	Hematocrit (Hct)*

Hemoglobin Conc. (Hb)* 

Mean Corp. Hb. (MCH)*

Mean Corp. Hb. Conc. (MCHC)* Mean Corp. Volume (MCV)*

Total Erythrocyte Count (RBC)*



	white blood cells


	
	Basophils, Eosinophils* Lymphocytes*

Macrophage/Monocytes* 

Neutrophils*

Total Leukocytes (WBC)*



	clotting potential


	
	Activated Partial-Thromboplastin Time* 

Clotting Time*

Platelet Count* 

Prothrombin Time*



	others


	
	Bone marrow cytology*

Reticulocyte counts*


    *These parameters are recommended in REDBOOK for subchronic toxicity studies. Add additional parameters  

     tested.

6. Comments:  


J. Clinical Chemistry

1. Fasting duration prior to blood collection:  

2. When in the study were the blood samples collected? 

3. How were the blood samples drawn?


4. Dose groups and number of animals tested:


5. Parameter examined:  

Table # [Heading]

	measurement related to
	examined
	not examined

	electrolyte balance
	
	Calcium* Chloride*,** Phosphorus* Potassium*,** Sodium*,**



	carbohydrate metabolism


	
	Glucose*,**


	liver function:

  A) hepatocellular

      (recommend at   

      least 3 out of 5  

      RED BOOK    

        PARAMETERS ) 

  B) hepatobiliary

      (recommend at   

      least 3 out of 5   

      RED BOOK 

        PARAMETERS)
	
	Alanine Aminotransferase 

   (ALT or SGPT)*,**

Aspartate Aminotransferase 

   (AST or SGOT)*

Glutamate Dehydrogenase* Sorbitol Dehydrogenase*

Total Bile Acids*



	
	
	Alkaline Phosphatase (ALP)*,**

Gamma-Glutamyl Transferase (GGT)*,**

Total Bile Acids*

Total Bilirubin*

5’ Nucleotidase* 



	kidney function
	
	Creatinine*,**

Urea Nitrogen*,** 



	others

(acid/base balance, cholinesterases, hormones, lipids, methemoglobin, and proteins)
	
	Albumin (A)* 

Globulin (G, calculated) or A/G Ratio*

Total Cholesterol*

Cholinesterase*

Total protein*,**

Fasting Triglycerides*


    *These parameters are recommended in REDBOOK for subchronic toxicity studies. Add additional parameters 

     tested. 

** These parameters should generally be given priority when adequate volumes of blood samples can not be obtained from test animals.   

6. Comments:  

K. Urinalysis

1. When were urine samples collected? 
 

2. Parameter examined: 


Table # [Heading]

	examined
	not examined

	
	Glucose*, Microscopic evaluation for sediment and presence of blood/blood cells*, pH*, Protein*, Specific Gravity*, Volume*


* These parameters are recommended in REDBOOK for subchronic toxicity studies.

3. Comments: 
L. Other Tests

1. Observations: 

2. Comments: 

M. Necropsy (Interim Sacrifice)

1. Was there an interim sacrifice? 

2. Dose groups and number of animals: 

3. Organs/Tissues weighed: 

Table # [Heading]

	examined
	not examined

	
	Adrenals*, Brain*, Epididymides*, Heart*, 

Kidneys*, Liver*, Spleen*, Testes*, Thyroid/parathyroid*, Thymus*, Ovaries*,   Uterus*


* These parameters are recommended in REDBOOK for subchronic toxicity studies.

4. Comments:  

N. Necropsy (Terminal)
1. Organs/Tissues weighed: 

Table # [Heading]

	examined
	not examined

	
	Adrenals*, Brain*, Epididymides*, Heart*, 

Kidneys*, Liver*, Spleen*, Testes*, Thyroid/parathyroid*, Thymus*, Ovaries*, Uterus* 


      *These parameters are recommended in REDBOOK for subchronic toxicity studies. Add additional parameters

       tested.

2. Comments:  

O. Gross Pathology Observations
1. Organs/Tissues Examined: 

2. Comments:   

P. Histopathology Observations
1. Organs/Tissues were collected from which dose groups?  

2. Organs/Tissues were examined from which dose groups? 

3. How were the organs/tissues prepared for histopathology observation?  

4. Organs/Tissues collected: 

Table # [Heading]

	system
	examined

	not examined

	digestive
	
	Salivary Gland*, Esophagus*, Stomach*, Duodenum*, Jejunum*, Ileum*, Cecum*, Colon*, Rectum*, Gall Bladder* (in case of mice), Liver* (middle, left and triangular lobes), Pancreas* 



	respiratory
	
	Nasal Turbinates*, Trachea*, 

Lung* (with main-stem bronchi)



	cardiovascular
	
	Aorta*, Heart* 


	reticulo- endothelial/

hematopoietic


	
	Bone Marrow* (sternum), 

Lymph Nodes* (1 related to route of administration, and 1 from a distant location), 

Spleen*, Thymus* 



	urogenital


	
	Kidneys*, Ovaries* and fallopian tubes*, Corpus Uteri*, Cervix Uteri*, Prostate*, Seminal Vesicle* (if present), Testes*, Urinary Bladder*, Vagina*



	neurologic
	
	Brain* (at least 3 different levels), Spinal-Cervical*, 

Spinal-Lumbar*, 

Spinal-Midthoracic*, 

Sciatic Nerve*, 

Harderian Gland* (if present) 


	glandular
	
	Adrenals*, Mammary Glands*, Pituitary Glands*, Thyroid/Parathyroid Glands*, Thymus*, 

Zymbal's Gland* (if present)



	other
	
	Bone (Femur)*, Eyes*, Skeletal Muscle*, Skin*, Epididymis* 




      *These parameters are recommended in REDBOOK for subchronic toxicity studies. Add additional parameters 

       tested.

5. Comments: 

Q. STATISTICAL METHODS
1. Methods of statistical analysis: 

Table # [Heading]

	methods of statistical analysis
	parameters tested

	
	

	
	

	
	

	
	


2. Comments: 

V. Results
R. DOSE VERIFICATION

1. Were doses verified? 


Table # [Heading]

	dose group
	targeted concentration 

 (ppm or mg/kg) 
	concentrations found in feed

(ppm or mg/kg)
	standardDeviation
	N*



	low
	
	
	
	

	mid
	
	
	
	

	high
	
	
	
	


* Number of measurements (N)

2. Verified by:    


3. Comments: 


S. FEED CONSUMPTION CHANGES

1. Observations: 

2. Comments: 

INTAKE OF TEST 
SUBSTANCE
1. Observations: 

Table # [Heading]

	dose group
	daily dose 

(mg/kg body-weight/day)

	control
	0

	low
	

	mid
	

	high
	


2. Comments: 

T. FEED EFFICIENCY

1. Was feed efficiency calculated? 

2. Comments:  

U. BODY WEIGHT CHANGES

1. Observations: 

2. Comments: 

V. CAGE-SIDE OBSERVATIONS

1. Observations: 


2. Comments: 


W. MORTALITY

1. Observations: 


2. Comments: 


X. OPTHALMOLOGICAL EXAMINATION
1. Observations: 

2. Comments: 

Y. HEMATOLOGY

1. Observations: 

Table # [Heading]

	SEX
	males 
	females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	red blood cells
	
	
	
	
	
	
	
	

	Hematocrit (Hct)
	%
	
	
	
	
	
	
	
	

	Hemoglobin Conc. (Hb)
	g/L
	
	
	
	
	
	
	
	

	Mean Corp. Hb. (MCH)
	
	
	
	
	
	
	
	
	

	Mean Corp. Hb. Conc. (MCHC)
	
	
	
	
	
	
	
	
	

	Mean Corp. Volume (MCV)
	L/L
	
	
	
	
	
	
	
	

	Total Erythrocyte Count (RBC)
	1012/L
	
	
	
	
	
	
	
	

	white blood cells
	
	
	
	
	
	
	
	

	Basophils 
	
	
	
	
	
	
	
	
	

	Eosinophils
	
	
	
	
	
	
	
	
	

	Lymphocytes
	109/L
	
	
	
	
	
	
	
	

	Macrophage/

Monocytes
	
	
	
	
	
	
	
	
	

	Neutrophils
	109/L
	
	
	
	
	
	
	
	

	Total Leukocytes (WBC)
	109/L
	
	
	
	
	
	
	
	

	clotting potential
	
	
	
	
	
	
	
	

	Activated Partial-Thromboplastin Time
	
	
	
	
	
	
	
	
	

	Clotting Time
	
	
	
	
	
	
	
	
	

	Platelet Count
	109/L
	
	
	
	
	
	
	
	

	Prothrombin Time
	
	
	
	
	
	
	
	
	

	others
	
	
	
	
	
	
	
	

	Bone marrow cytology
	
	
	
	
	
	
	
	
	

	Reticulocyte counts
	1012/L
	
	
	
	
	
	
	
	


 (Specify a method of statistical analysis): * p<0.05, ** p<0.01

2. Comments: 

Z. CLINICAL CHEMISTRY

1. Observations: 

Table # [Heading]

	SEX
	males 
	females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	electrolyte balance
	
	
	
	
	
	
	
	

	Calcium
	mmol/L
	
	
	
	
	
	
	
	

	Chloride
	mmol/L
	
	
	
	
	
	
	
	

	Phosphorus
	mmol/L
	
	
	
	
	
	
	
	

	Potassium
	mmol/L
	
	
	
	
	
	
	
	

	Sodium
	mmol/L
	
	
	
	
	
	
	
	

	carbohydrate metabolism
	
	
	
	
	
	
	
	

	Glucose 
	mmol/L
	
	
	
	
	
	
	
	

	liver function:

   A) hepatocellular
	
	
	
	
	
	
	
	

	Alanine Aminotransferase 

   (ALT or SGPT)
	U/L
	
	
	
	
	
	
	
	

	Aspartate Aminotransferase 

   (AST or SGOT)
	U/L
	
	
	
	
	
	
	
	

	Glutamate Dehydrogenase
	U/L
	
	
	
	
	
	
	
	

	Sorbitol Dehydrogenase
	U/L
	
	
	
	
	
	
	
	

	liver function:

   B) hepatobiliary
	
	
	
	
	
	
	
	

	Alkaline Phosphatase (ALP)
	U/L
	
	
	
	
	
	
	
	

	Gamma-Glutamyl Transferase (GGT)
	U/L
	
	
	
	
	
	
	
	

	Total Bile Acids
	mol/L
	
	
	
	
	
	
	
	

	Total Bilirubin
	mol/L
	
	
	
	
	
	
	
	

	5’ Nucleotidase
	U/L
	
	
	
	
	
	
	
	

	kidney function
	
	
	
	
	
	
	
	

	Creatinine
	mol/L
	
	
	
	
	
	
	
	

	Urea Nitrogen
	mg/dL
	
	
	
	
	
	
	
	

	others
	
	
	
	
	
	
	
	

	Albumin (A)
	g/L
	
	
	
	
	
	
	
	

	Globulin (G, calculated)
	g/L 
	
	
	
	
	
	
	
	

	A/G Ratio
	
	
	
	
	
	
	
	
	

	Total protein
	g/L
	
	
	
	
	
	
	
	

	Total Cholesterol
	mmol/L
	
	
	
	
	
	
	
	

	Fasting Triglycerides
	mmol/L
	
	
	
	
	
	
	
	

	Cholinesterase
	U/L
	
	
	
	
	
	
	
	



(Specify statistical method of analysis): * p<0.05, ** p<0.01

2. Comments: 

AA. URINALYSIS

1. Observations: 

Table # [Heading]

	SEX
	males 
	females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	Glucose
	mmol/L
	
	
	
	
	
	
	
	

	Microscopic evaluation for sediment and presence of blood/blood cells
	
	
	
	
	
	
	
	
	

	pH
	
	
	
	
	
	
	
	
	

	Protein
	g/L
	
	
	
	
	
	
	
	

	Specific Gravity
	
	
	
	
	
	
	
	
	

	Volume
	L/time
	
	
	
	
	
	
	
	


2. Comments: 

AB. OTHER TESTS

1. Observations: 

2. Comments: 

AC. ORGAN WEIGHTS

1. Observations: 

Table # [Heading]

	SEX
	males 
	females 

	DAILY DOSE

 (mg/kg body-weight/day)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS
	
	
	
	
	
	
	
	

	BODY WEIGHT (gram)a
	
	
	
	
	
	
	
	

	BRAIN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	ADRENALS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	EPIDIDYMIDES
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	HEART
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	KIDNEYS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	LIVER
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	SPLEEN
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	TESTES
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	THYROID and PARATHYROID
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	THYMUS
	
	
	
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	
	
	
	

	OVARIES
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	

	UTERUS
	
	
	
	
	

	Absolute Weighta
	gram
	
	
	
	
	

	Per Body Weighta
	%
	
	
	
	
	

	Per Brain Weighta
	%
	
	
	
	
	


a: Group means at the end of terminal necropsy are shown. 

(Specify methods of statistical analysis): * p<0.05, ** p<0.01

2. Comments: 

AD. GROSS PATHOLOGY CHANGES OBSERVED

1. Observations: 

2. Comments: 

AE. HISTOPATHOLOGY CHANGES OBSERVED

1. Observations: 

Table # [Heading) 

	
	NUMBER OF ANIMALS 

WITH, GROSS, NON-NEOPLASTIC, OR NEOPLASTIC LESIONS



	SEX
	males 
	females 

	DAILY DOSE

 (MG/KG BODY-WEIGHT/DAY)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS EXAMINED
	
	
	
	
	
	
	
	

	DIGESTIVE SYSTEM
	
	
	
	
	
	
	
	

	ORGAN/TISSUE # 
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	RESPIRATORY SYSTEM
	
	
	
	
	
	
	
	

	ORGAN/TISSUE #
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	CARDIOVASCULAR SYSTEM
	
	
	
	
	
	
	
	

	ORGAN/TISSUE #
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	RETICULO-ENDOTHELIAL /HEMATOPOIETIC SYSTEM
	
	
	
	
	
	
	
	

	ORGAN/TISSUE #
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	UROGENITAL SYSTEM
	
	
	
	
	
	
	
	

	ORGAN/TISSUE #
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	GLANDULAR SYSTEM
	
	
	
	
	
	
	
	

	ORGAN/TISSUE #
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	


(Specify methods of statistical analysis): * p<0.05, ** p<0.01

# Organs/tissues listed under section IV.P.

In general, data at end of dosing period can be shown; however, if there were additional noteworthy findings at earlier timepoints, these should be included.  Note severity of lesions as needed.  

2. Comments: 

AF. NEUROTOXICITY

1. Observations: 

Table # [Heading]

	
	NUMBER OF ANIMALS 



	SEX
	males 
	females 

	DAILY DOSE

 (MG/KG BODY-WEIGHT/DAY)
	0

CONTROL
	
	
	
	0 CONTROL
	
	
	

	NUMBER OF ANIMALS EXAMINED
	
	
	
	
	
	
	
	

	OBSERVATIONS OF NERVOUS SYSTEM TOXICITY +
	
	
	
	
	
	
	
	

	OBSERVATION
	
	
	
	
	
	
	
	

	OBSERVATION
	
	
	
	
	
	
	
	

	OBSERVATION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	GROSS- AND HISTO-PATHOLOGY CHANGES IN THE NEUROLOGIC SYSTEM # 
	
	
	
	
	
	
	
	

	ORGAN/TISSUE
	
	
	
	
	
	
	
	

	GROSS LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	NON-NEOPLASTIC LESION
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	

	NEOPLASTIC LESIONS
	
	
	
	
	
	
	
	


+ See under section IV.G for the types of observation for nervous system toxicity: List noteworthy findings.  If additional parameters (other than those in the Template) showed noteworthy changes, these should be added to the tables.  In general, include data at the end of the dosing period.  However, if one observes additional noteworthy findings at earlier timepoints, these should be included.  Footnotes should be used as needed to provide additional information about the tests or the results.  Note the severity of the abnormal observations using the following scales; + Mild, ++ Moderate, and +++ Marked or other scales, as appropriate.

# Organs/tissues listed under section IV.P

2. Comments: 

VI. Evaluation and Comment on Study

VII. Summary and Conclusions

AG. BRIEF SUMMARY OF MAJOR FINDINGS FROM THE STUDY
AH. RELATIONSHIP BETWEEN DOSE AND INCIDENCE/SEVERITY OF LESIONS OR ABNORMALITIES
AI. WAS THERE A TARGET ORGAN?
AJ. NOEL
1. Was there a no observed effect level? 

2. Comments: 

VIII. References






�Make note of: study file location (Volume, pages), study title/report #, testing facility name, publication dates of study, study objective, and comments, if needed. 


�Indicate Yes or No for the Questions A and B. However, please elaborate on the type of GLP compliance (USFDA, OECD, etc.) or make other notations.


�Description of the test substance should be given, including purity, any possible contaminants or impurities, and any potential properties of the test substance that could have affected its integrity. Are there factors that might have affected the actual administered dose, as opposed to the intended dose?





�After you put a blinking cursor on the http address, (CTRL +) left-click once to follow the link and wait.  Enter a chemical name, CAS Number, or molecular formula inside the search window and click ‘search’ button.  Right-click inside the molecular structure and select ‘copy’ submenu.  Return to your document and put the cursor underneath item #4 (molecular structure).  Right click to open up the menu options and select ‘paste’ submenu.  You can drag the structure to any position you want and resize.


If preferred, use other methods of depicting the molecular structure.


�Indicate how the test substance was administered and whether any vehicle was used to dissolve/suspend the test substance (e.g., dissolved in corn oil and mixed into the feed).  Also note if there was adequate testing for concentration and homogeneity (appropriate tests with replicates) and whether there were stability tests done.  Was the strength of the test material checked over the period and under the conditions that the feed mix, test article in vehicle, etc., would be stored? 





�Note anything that might have affected the study. Use the comments to indicate other factors that might have impacted the study.





�Provide adequate details. Use the comments to indicate additional information about the experimental design.  To change the table, place cursor in the row or column that you wish to modify, then from the ‘Table’ menu, use ‘Select Row’ or ‘Select Column’ to highlight the row or column that you wish to change, and use the ‘delete’ or ‘insert’ functions to make your changes.





�Indicate the measurements or observations that were made by highlighting the parameter and dragging the term into the ‘Examined’ side.  Those parameters not examined will remain in the ‘Not Examined’ side. Use the comments to indicate when observations were made and any other notable fact.





�Drag and drop to indicate parameters that were examined.  Use comments to indicate other important information.


�Drag and drop to indicate parameters that were examined.  Use comments to indicate other important information.


�Note when urine was collected for testing, the groups that were affected, and drag and drop the parameters that were tested. Make comments on anything considered significant or treatment-related.


�If other tests were conducted, make note of the endpoints considered significant or treatment-related.





�If there was an interim sacrifice (e.g., at 30 or 60 days), make notes on which groups were affected, and the number and sex of the animals that were tested.





�Note whether there was a verification of the doses being administered (by what analytical methodology and in which laboratory). Was this done more than once? Were there adequate data to calculate the actual dose that was administered?





�Note any statistically or biologically significant feed consumption changes. Note feed consumption changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.





�Considering the level of feed intake and the level of test substance in the feed, what was the dose actually being delivered to the animals?





�Note when feed efficiency was determined; if any changes were observed; if feed efficiency was calculated for all groups or only selected groups; and if calculations were made per group, per cage, or per animal.





�Note any statistically or biologically significant body weight changes. Also note body weight changes that are not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  You may wish to insert graphs or tables in this section.





�List significant, dose-related abnormal cage-side observations.  For neurotoxicological observations, also use a Table in Section V. P. (see Section IV. G. for parameters).





�For each animal with an unscheduled death, note the group, date of death, and any observations, including lesions observed at necropsy.





�Note findings that were statistically or biologically treatment-related.  Also note changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.





�Note findings that were statistically or biologically treatment-related.  Also note changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.





�Note findings that  were statistically or biologically treatment-related.  Also note changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.





�When other tests were conducted, make note of the tests and any significant treatment-related effects.





�Note findings that were statistically or biologically treatment-related.  Also note changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The comment section is available to explain data findings, if needed.





�Note findings that were statistically or biologically treatment-related.  Also note changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The type of lesion should be noted. The comment section is available to explain data findings, if needed. Also note the findings in Histopathology Section V.O. below.





�Note findings that were statistically or biologically treatment-related.  Also note changes that were not statistically significant (e.g., at low or mid dose) but could indicate a treatment-related trend.  The type of lesion should be noted. The comment section is available to explain data findings, if needed.





�Provide summary tables of all positive effects. In addition, provide an explicit statement as to whether or not the test substance may represent a potential neurotoxic hazard.


�Give your evaluation of the study: what was done well; what the problems were; did the study accomplish what it was supposed to do? 





�Summarize the key findings from the study. Was there a dose-effect relationship? Were target organs identified? Was a NOEL achieved for each significant effect/observation? What was the NOEL?  The whole study should be summarized in this section.
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